
DREAMWEAVER 4

Tables
What is a table? 
Here’s some necessary background info:  Originally tables were designed to display
data in tiny rows and columns, mostly text and numbers.  But soon, thereafter, people
realized you could also place images in the table and manipulate them so you could lay
out entire pages within them.  After that, it became nearly impossible to come across a
layout on the web that didn’t rely almost entirely on tables.  And that’s pretty much the
case today.  Tables give you the ability to look like more they came out of a page layout
program like InDesign or Quark Express, and you won’t find any professional page today
that’s not reliant on tables. Tables are one of those things that you need to learn and
practice.  While tables are probably the most commonplace way of designing pages,
there is a slowly growing movement in the webdesign community  to encourage
webdesigners to use CSS to lay out pages.  CSS offer the same results as tables and
are more flexible, and they’re more difficult to learn.  We’ll learn a little about them soon.
It’s still important for you to have a good firm foundation in tables before you start using
tools that will do the work for you.

Selecting table regions 
You need to know how to insert the tables in the first place and then select parts of them
and modify their properties.  There are a couple of ways to insert tables.  Easiest way it

to go on the Common Insert menu and select the “Table” icon.    You’ll see a
popup window where you can set up the initial properties of the table.  By default it’s 3
rows/3 columns.  Then there’s the table width column, which can be pixel based or
percentage based.  You need to make sure you have Table Widths display on, so make

sure you go to “View” icon and check the Table Widths option to enable you to
view Talbe Widths. This is a feature in DW that allows you to see widths and columns,
but you probably want to leave it off until you need it, b/c it can get in the way.  There are
3 diffferent table modes that you can use to see your table.

 If you go to the View menu and look under Table Mode, you’ll see
1. Standard,
2. Expanded Tables Mode and
3. Layout Mode.

Standard mode is in Default.  Expanded Table mode will make your table look a little
bigger, and supposedly it’ll make your table easier to edit, but it’s not very representative
of how the table looks like, so you probably will not want to use it.  We’ll deal with
Layout mode a little later. Make sure you have Standard mode selected.

Insert a table.  Once it’s been added to your page, it’s never set in stone.  But before you
can change it, you need to know how to select parts of the table.  If you wanted to select
top row, drag across the top to select. They’ll have a black or blue border around them.
Try selecting cells, up or down.

That’s easy when there’s empty cells. But once you have content in there, it’s harder to
select them.  A great feature in DW is when you move curser to the left of the table, this



red highlight appears around the top row and your curser turns into  a black arrow that

points to the right: If you click on that cell, then
those cells will be selected, the entire row. The same thing works for columns.  It also
works for the entire table.  If you DO select the entire table, try to do it from the bottom or
the right.  If you select from the top, you sort of can select columns a little too easily.  B/c
this is DW there’s ANOTHER way to select cells.  Down in the TAG section you see a
<table> tag, a <tr> “table row” tag, and a <td> “table data” tag.  That’s how you write a
table cell in html.  If you select the tags, then you have tables selected.

Depending on what you have selected, you have different properties in the Properties
Inspector.  You can change things in the Properties Inspector.

When you add new rows, it adds rows to the BOTTOM of the table.
Same thing if you add columns…adds new columns to the right.
If you did want to add rows or columns within the table, you would have to put your
cursor in the text row, and choose Insert/Table Objects/Insert row below or above or
column to left/right.  And just like you can add rows and columns you can delete them.
It’s important to keep in mind, you can only delete ENTIRE rows and columns.  If you
just highlight a single cell and hit   delete, nothing is going to happen. A table HAS to be
a rectangle, there’s no way around that.  There can’t be an irregular shape.
A Table doesn’t, however, have to be a big boxy grid.  You can merge cells together

easily:  In the properties inspector there’s a merge button.  
It’s usually better to merge or split cells when they’re empty.   The split button looks like
this:

You can split into columns or into more rows.
Once you’ve selected your cells there’s lots you can do. While you can select cells and
work with them in Properties Inspector, you can also Right Click or Control Click (Mac)
and work with them in this contextual menu.  If you go to the Table section, that menu
includes lots of things available in the Properties Inspector.

Pixel-based tables 
You’ll work with new files.  Copy the Exercise File “09_Tables” and put it on your
desktop.  You’ll need to define the site in Dreamweaver (Site/New site), search for
folder on your desktop.

When you insert a table there are 2 different kinds of tables:  Percentage based or
pixels.  If you want to be able to shift the text wrap or position of its contents based on
the size of the User’s browsers’ window, you want a percentage based table. If you want
your page to be static to be unchanging no matter what size the user’s browser is, you
want a pixel-based table.



Open up the file text.html.  There’s regular text on the page.  Preview it in your browser.
The text is fine, but it doesn’t look interesting.  It’s also relying entirely on the browser
window to control its text wrap, so if you make the browser window bigger or smaller, the
text just wraps within it.  It’s not that big of a deal, but if page is on a larger window,  it
will be difficult to read.  It would be easier to put the text into columns.

Open up the file Basic.html (an empty blank page that’s been saved already).
Insert table:  3 columns, 2 rows. Table width 600 pixels.  Border width 0 (by doing this
you’re basically making an INVISIBLE table).
Leave all the other boxes blank.  Click on OK.  There’s your table.  You want to contain
the content of this text page in the table.  Select first paragraph, copy it and place it in
the bottom cell of the 2nd column.  As you pasted it, the borders of the tables collapsed.
Once you put content in the cells, all the other rows and columns will collapse.
To prevent this from happening you want to set a width and height for the cell.

(If you move tab across the table, it’ll move from cell to cell. Shift tab allows you to go
backward.)

 Since it’s a 600-pixel  wide table, you just want to divide into 3:  200, 200, 200.
So in W, type 200 for the cell block you’ve got your text in.  Do the same thing for the
other columns. Now that everything is 200, the table cells still look funny, but as soon as
you add the content, it’ll be measured okay.  Do another text drop.  Then to fit the title of
the text, you’ll want to merge the top two right cells. Here’s the initial layout.  Look at it in
the browser.



Doesn’t look good!  The second column has a big gap.  Why?  When you’re working in a
table cell, you still have normal alignments, you also have Vertical to deal with.  By
default anything you’ll drop into the cell will be aligned to the center of the cell.
So with your cursor in that cell, go down to the Horz and Vert alignment buttons in the
Properties Inspector menu, and change from Default to Top.  Do the same for the other
cell that has the larger Paragraph in there, just to get the code in there. No visual
change, but the code has been added.

The text blocks are also too close together.  You need to select the entire table to fix
this:  go from bottom up to select the table, or with your cursor in the table, select the
<table> tag.  Look at he Cellpad and Cellspace fields in the Properties Inspector.

Similar to Margins and Padding.  Padding is the INSIDE of the Cell.  Padded cells in the
crazy house have their padding on the inside of the cell—to help you remember.
Cellspace represents space between the cell.  Experiment with cell space and cell pads.
Try entering 20 pixels with each.  Then try 10 pixels.

Next thing you might want to do is change text formatting.  Bring the title text Vertical
alignment=bottom.  Change things into Verdana.  Apply CSS styles.
Notice, when you preview this in a browser, that this is a pixel based table.  If you make
the window bigger or smaller, the text does NOT move around.

Percentage-based tables 
When you set the percentage size of a table it’s going to be 75 or whatever percent you
choose, of whatever is containing my table.  So if you put the table on the entire page,
it’ll be 75% the width of the page.  If you put the table into another table, it’ll be 75% of
the cell you put the table into.
Normally you’re really concerned with the Table WIDTH: how wide the table gets.
And you just let the table get taller as necessary.
There are height settings, but that’s not a tag that’s supported in most modern browsers,
so avoid the height tag.
Demonstration:  Take the same text you used in first exercise.  Build a 2 row/2 column
table with width at 75%.  Put first paragraph on Bottom left and 2nd paragraph on bottom
right.
Select top row and merge cells together, and get the title and paste that in there.
You have to make sure you click IN the cell and see the flashing cursor if you want to
paste text in there.
Select table tag so you have the whole table selected.  Fix the cellspace and give it a
“10” so there is a 10-pixel space between the text and the table walls.  Select both cells
and make sure the vertical selection is “Top” and Horizontal selection is “left” (even
though that’s the default)./
Go to browser and see what is meant by a percentage-based table:  text also resizes
with the window.
It’s up to you (and your piece) to figure out if you want pixel based or percentage-based
table.
In the width area, if  you want BOTH cells to be exactly even (they won’t be), then in the
W field type 50% (if you just type 50 it’ll assume 50 pixels, so you HAVE to put a
percentage sign in there). So when you resize, your table cell will stay 50 percent the
width of the table.



Nesting tables 
You might want to combine tables.  Putting a table inside another table is called Nesting.
You might want to next a pixel-based table into a percentage-based table, or vice versa,
or a pixel-based table into a pixel-based table.  You can do this almost infinitely….tables
within tables within tables.  An example of creating a nested table.
Demonstration:  Create a new table:  1 row and 1 column…single sell table, 100% of
browser window width and click OK.  Why would you want to do this?  This is a common
method if you want to have something centered on your page or multiple things centered
on your page, you can put all of them into a single celled 100% width table.  You center
by choosing Horz alignment as Center (in Properties Inspector).  Just as a general rule,

you should always set the general alignment (Horz, Vert) first, 
 and then if you need to set something specifically within that, choose this alignment

option: 
Grab an image from inside the images folder… grab something called “history.jpg”  Put
in an image Tag, and put in a name.  Now you’re going to want some text. Grab ALL the
text from the text document, go back to basic and perform the paste.  View in browser.

B/c this is a 100% table, notice that the text wraps to the window, but everything stays
center.  The image being centered and the title being centered is good, but what if you
want the text to be aligned to the window?
Here you can come in, select the area you want centered (text) and click left.  The
overall rule is “center” but when you specifically select paragraphs and align to the left,
the specific overrides the general.
It WOULD be better to have the text in the table, and control the way the text wraps.
So you accomplish this by nesting another table in the first table.  You’ll want to select a
pixel-based table b/c you don’t want the text to change.  So delete the text.  Select insert
table button and define table as a pixel-based table.  Try width of 375 pixel (you can
always change this later).  Then you can paste the text back in and there it is.
Everything is still centered, but no matter how big the browser window is, the text still
doesn’t wrap.  Make it wider, select table using the table tag…look at the tags and
identify where you are in the tags…make it 450 pixels.  Make the default alignment to be
centered.
A very practical example of nesting 2 tables together.

EXERCISE:  NEST A Percentage-based table into a Pixel-based table

Layers and Layout Modes
Layout modes and layers are more advanced.  You can definitely build and maintain a
website using all of the skills you’ve learned up until now.  Everything here requires
practice.

Copy 10_layout folder onto your desktop.  Define a new site.  Site/Newsite.  Give it a
name (e.g. Layout).  Find folders on the desktop.  Start by opening up
tracing_image.html…a blank document that’s already been set up.  One of the most
frustrating things about DW is that you can’t just drag text on an empty page and do



anything you want.  On an empty page you can type some text and align to left center or
right, but you can’t just select and drag it anywhere on the page that you want.   You
could create a table and have one cell of the table in the place that you want.  Wouldn’t it
be nice to put stuff in wherever you want?  Well, you can do this with Layers.
Layers use a special Html tag called <div>.  By assigning coordinates to the div tag
through CSS you can place it anyway on the page.  You don’t need to enter any of these
coordinates, you just need to drag them around on the screen.
Most web developers mock up a page in Photoshop or Fireworks, which gives them the
ability to add and rearrange documents.  Then they may use this as a mock.  DW let’s
you go further, DW lets you place your mock up as a background…it’s called working
with a Tracing Image.  In assets panel, find Tracing_image.gif
To use as a tracing image on this page, go to Modify/Page Properties, and select, under
Category, Tracing Image.  It allows you to browse for the image, so do so. Look inside
the images folder and select tracing_image.  Click OK.  Apply, and see how it looks on
page.
What you want to do is start putting content on top of the Tracing Image.  It’ll only show
up on DW.  If you view in browser you won’t see it.  Once you start adding content, it’s
hard to tell which is which.  So go to the Modify/Page Properties window again, and
bring down the opacity of your image.

Adding layers 
To insert first layer, go the go to Layout Section of Insert bar and select the Layout

menu, and choose Draw AP Div. There’s a cursor inside, you can start
typing.  It has a handle.  When you click on that handle, 8 other handles appear, and if

you click on main handle, you can drag layer all over the web page.  Position
layer over tracing image to add real image onto page.  Put in the header first.  Resize
first layer, drag header.gif into the new layer.  If you see a slight border, you can still see
the layer if it’s not selected.  Resize the layer to try to match the image.  You know the
image is selected if you can see 3 handles.  By selecting the LAYER you can see 8
handles, and you have layer properties in the Properties Inspectors’ box.  It’s good to
have layers precise when you have images in them.

Another way to add a layer is to go Insert/Layer Objects/AP Div

Add a layer. Draw around the main text.  Give it a layer ID.  Type in the text, or copy and
paste.  Select and copy.  Drawing is a preferred method b/c you can check size just like
that.
You can also drag out Guides.  Go to Ruler/Show, and put cursor into the ruler and then
use guides to line up with the tracing image.  You can use arrow keys on keyboard to
move layers up and down.
To get a different background, go to Modify/Page Properties, select Appearance, and
select a bg color. Then you can delete the tracing image.

Modifying layers 
Notice that the Layers Panel (AP Element Panel) is grouped with the CSS Panel group.
That’s b/c layers are essentially CSS.  If you click to code view and scroll up to the top,



you can see all layers are enclosed in a div tag.  A div tag is an all purpose tag that
denotes a division or section of the page.  Each one of the div tags has an associated id
Z-index means what is on top and what is on bottom (Z-1, Z-2, Z-3)
If select the layer you can see the coordinates in the Properties inspector.  You can
change the Z index (stacking order), color, etc.  You’re not limited to just the properties
in the properties inspector.  You should use CSS:  if you want a new border and find that
layer’s style (CSS sheet)—whatever layer ID you gave it—and double click to open up
CSS editor, and add a border *or whatever you want.  If text is too close to the border or
running off edge, go to the CSS rule and add padding (10 pixels is good).  Look in
browser.  If it’s still running outside of border, add more padding.  The only way to be
sure that you size your layer right, is to look at the image and look at the size of the
image itself.  Borders can REALLY COMPLICATE layer sizing and the way you view
things in browser.  So make sure you size the layer to the same size you have the image
or text body.
If you have the layer of the Text selected, look down in the Properties inspector:  you
have a field called “Overflow.”:
If it’s on Visible, then you can work on resizing the text box so that all the text fits in
properly.
If you choose scroll, you can automatically put a scrolling box of text on your page.  Auto
is also about the same thing as scroll.
It’s nice to have hashmarks so you can see how much padding in a layer you have:

If you don’t have these marks *which are helpful, then go to the  icon and choose
CSS Layout Box Model.  If you uncheck it, the hash marks go away.  Also in View, you
have CSS Layout outlines…you can see a little dotted line between layers. Helps you
differentiate between layers. Turning on CSS Layer backgrounds colors all your
individual layers so you can tell at a glance which layers are where.

Converting layers to tables
Tables and not layers are readable in all browsers.  In Modify menu,
Modify/Convert/Layers to table.
It’s not possible to have overlapping layers when you’re using tables.  So if you have
overlapping layers, you have to rearrange slightly; go to the Layers Panel and select
“Prevent Overlaps” if drawing layers and it’ll make it impossible to overlap layers.
In the Convert Layers to Table dialogue box, it’s Good to choose “Most Accurate”

Layout mode 
Layers let you create more complex layouts in a much shorter time than if you did this
manually.
One of the potential disadvantages is that you can sometimes end up w/ really
complicated code, b/c DW doesn’t write in terms of nested tables, but in terms of really
complicated tables.
 Layout mode is a nice alternative to tables:  It allows you to use special layout tables
and cells so you can put content on your page any way you want.
You an also use nested tables.
Choose New File, call it Mode.html.  Get a blank page.
Make sure you’re in the layout section of the Insert menu and select “Layout Mode”
You can also go View/Table Mode/Layout Mode.



Layout mode activates layout table and layout cell tools.: 

These are the two tools you’ll need.  First, select the layout table tool: 
Draw a huge table with no cells over the whole page.  Then select the Cells tool.  Draw
various cell sizes.  Copy and insert some text.
It’s a good idea to keep the cell close to the image and text you’re inserting b/c you’ll
want to optimize your space there.
Once you’re done w/ your layout table, it’s a good idea to select the entire table itself,
and then drag the table to the edge of all the other cells:  that way DW has to write less
code.
This is a pixel-based table.  By default it creates a pixel-based table.
You can also create a percentage-based table using this method.  If you look at the
numbers in the green lines at the bottom of the table.  If you click on these options, you
can choose “Make Column Autostretch or Add Spacer Image.”  The autostretch
cause it makes the table stretch to match the width of the document window.  You’re
turning it into a percentage based table.

ALSO, you can convert your layout mode layout to a table:
Modify/Convert/AP Divs to Table
Note: You can’t do this if you have overlapping layers.

(AND you can also convert tables to layers!)



Homework

Formatting tables 
You can change appearance of table.  Close out of previous tables.  Go back to the
09_Tables folder and open up a document called format.html.  Here you have a table
with different types of teas, their names and how much they cost.  You can add
background colors to the entire table and also to rows.  Select Properties
inspector….(make sure it’s entirely expanded), pick a background and a border color.
Check it in your Browser….you’ll be surprised that it’ll look different in different browsers.
Be aware that different browsers will render your border colors differently.  CCS will
make your colors more consistent.
You can also set background for a specific cell.  Let’s say you want to make your top row
a different color…drag and select entire row; in Properties Inspector you have BG, which
is background color.  Pick a slightly different color.  Here the specific overrides the
general again.
You can also set background images.  If you have a specific background image, you go

to your Bg Image field  and if you
have an image you want to use, point to the file.  The image will repeat itself (tile) in the
table.
If you want to add colors to your table and are not so good at picking colors go to
Commands/Format Table to choose from predesigned color schemes.  Find one you
like and click Apply.  It not only formats color but aligns text according to the format
design, etc.  You can change things within the design.

CSS table borders 
Setting a border color “manually” is not especially consistent across browsers.  If you
definitely want a border around your table, it’s best to use CSS.  Set border to 0 in the

Properties’ Inspector box.  Go over to CSS Styles.  Create a new style. 
For this demonstration make it local and define a tag. Redefine a table tag (choose from
long list; drop down menu:

Go to border category, and change border styles.  Apply that style.
So since you applied it to table tag, any table with the table tag will have that style.
It only applied the style to the border…what about the indiv. Cells? Go and create
another CSS rule, to the table cells themselves (<td> tag).  Change styles there and
click okay, and look in the various browsers.  Experiment with CellPad and CellSpace.  If
you put a 0 in there will be no space.  If you have no 0, the default is to put a little space
in there. If lines are too thick, create a style for the table border that are not all the way
around.
Start fresh, get rid of all the border and cell styles.  Create a new border tag CSS rule.
And in the Bottom column select “solid” and “thin”/ in the Left select “solid” and “thin.”
Click on OKAY.  So for the cap covering top and right hand side, create a new CSS rule
to the Table tag.  This time apply style to Top and select “solid” & “thin” and on the Right
select “solid and “thin”.  So you have a nice thin border around all the table and the cells.
Preview in browser.
DO YOUR BEST TO CREATE:  A website with tables, text and images, defined in CSS.


